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Dear Reader,

Thank you for choosing the AUTODESK FUSION 360 ALL IN ONE WORKBOOK. This book is 

part of the CADIN360° learning series, created to help engineers, students, and 

professionals master Fusion 360 through structured and practical exercises.

This book contains over 500 carefully crafted practice drawings, including:

• 200 2D Sketching Exercises

• 200 3D Modeling Exercises

• Comprehensive Assembly Models with 150+ Individual Part Drawings

We founded CADIN360 in 2016 with the goal of delivering practical, high-quality learning 

material for CAD software. More than 9 years later, we’re still committed to producing 

consistently exceptional books. With each of our titles, we’re working hard to set a new 

standard for the industry. From the paper we print on, to the authors we work with, our goal 

is to bring you the best books available.

I hope you see all that reflected in these pages. I’d be very interested to hear your comments 

and get your feedback on how we’re doing. Feel free to let me know what you think about 

this or any other CADIN360 book by sending me an email at cadin360@gmail.com

If you think you’ve found a technical error in this book, please visit  

https://cadin360.com/contact-us/. 

Customer feedback is critical to our efforts at CADIN360.

Best regards,

Sachidanand Jha

Founder & CEO, CADIN360

https://cadin360.com/
mailto:cadin360@gmail.com
https://cadin360.com/contact-us/
https://cadin360.com/contact-us/
https://cadin360.com/contact-us/
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This book is copyrighted and the CADIN360 reserves all rights.

No part of this publication may be reproduced, stored in a retrieval system or transmitted, 

transcribed, stored in retrieval system or translated into any language, in any form or by any 

means, electronic, mechanical, photocopying, recording, scanning or otherwise, without the 

prior written permission of the publisher & Author.

Limit of Liability/Disclaimer of Warranty:
The publisher and the author make no representations or warranties with respect to the 

accuracy or completeness of the contents of this work and specifically disclaim all 

warranties, including without limitation warranties of fitness for a particular purpose. No 

warranty may be created or extended by sales or promotional materials. The advice and 

strategies contained herein may not be suitable for every situation. This work is sold with 

the understanding that the publisher is not engaged in rendering legal, accounting, or other 

professional services. If professional assistance is required, the services of a competent 

professional person should be sought. Neither the publisher nor the author shall be liable 

for damages arising herefrom. The fact that an organization or Web site is referred to in this 

work as a citation and/or a potential source of further information does not mean that the 

author or the publisher endorses the information the organization or Web site may provide 

or recommendations it may make. Further, readers should be aware that Internet Web sites 

listed in this work may have changed or disappeared between when this work was written 

and when it is read. 

Examination Copies
Books received as examination copies in any form such as paperback and eBook are for 

review only and may not be made available for the use of the student. These files may not be 

transferred to any other party. Resale of examination copies is prohibited 

Electronic Files & Usage Rights:
The electronic file/eBook in any form of this book is licensed to the original user only and 

may not be shared, distributed, resale or transferred to any other party. To access files, the 

user must contact cadin360@gmail.com with valid proof of purchase. Unauthorized 

distribution of the files is a violation of copyright law.

Disclaimer:
All product names, logos, brands, and registered trademarks mentioned in this publication 

are the property of their respective owners and are used for identification purposes only.
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AUTODESK FUSION 360 ALL IN ONE WORKBOOK

❖ This book contains over 500 CAD practice exercises, organized as:

 1. 200 2D Sketching Exercises

       2. 200 3D Modeling Exercises

       3. Assembly Projects with 150+ Part Drawings

❖ This book is a practice workbook. It does not include step-by-step tutorials for creating 

2D drawing, 3D models and Assembly.

❖ SI units (millimeters) are used for all dimensions.

❖ Third Angle Projection is used throughout this book.

❖ This book is for AUTODESK FUSION 360 and also suitable for Other Feature-Based 

Modeling Software such as Inventor, Catia, SolidWorks, NX, Solid Edge, AutoCAD, PTC 

Creo etc.

❖ Designed for students, engineers, drafters, and designers looking for extensive CAD 

practice using Autodesk Fusion 360.

❖ The exercises cover a wide range of real-world modeling challenges—from simple 

sketches to complex assemblies—offering clear, concise, and structured drawing 

practice.

❖ Exercises are organized to gradually develop beginner to advanced-level design skills.

❖ Each exercise is self-contained, and can be completed independently.

❖ Assembly drawings follow industry standards to help improve visualization and multi-

part modeling skills.

❖ All dimensions are in mm. Assume missing dimensions logically.
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 HOW TO USE THIS BOOK

This book contains over 500 CAD practice exercises, designed for self-paced learning using 

Autodesk Fusion 360 or any feature-based modeling software.

• 2D Sketching Exercises: Start here if you're a beginner or learning how to use the sketch 

environment. 

• 3D Modeling Exercises: Follow after mastering sketching. Practice creating solid models 

using the provided dimensions.

• Assembly Drawings: Use after completing part models to understand multi-part 

assemblies, relationships, and constraints.

Tips for Best Use:

• Complete the exercises in order, or jump to any skill level you prefer.

• All dimensions are in millimeters.

• Where dimensions are missing, apply logic or practice estimation.

• This book is ideal for both students and professionals preparing for industry design work.

Note: 

 This book is available in multiple formats – Black & White, Standard Color, and 

Premium Color editions.

  Happy learning!
  – Team CADIN360

©Copyright 2025 CADIN360, All rights reserved
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MASTER FUSION 360:
UNLOCK SKETCH MODE

WITH EXPERT TIPS



Introduction
Entering Sketch Mode in Fusion 360 is a fundamental skill for users of this powerful 3D CAD
software. As a beginner, navigating the interface and understanding how to create and work with
sketches can be overwhelming. In this comprehensive guide, we'll walk you through the process
of entering Sketch Mode, highlighting the key steps and best practices for creating accurate and
efficient sketches.

Preparing for Sketch Mode
Before entering Sketch Mode, it's essential to understand the fundamental concepts of Fusion
360 and its interface. Familiarize yourself with the user interface, including the toolbar, menus,
and workspace. Make sure you have a clear understanding of the different modes in Fusion 360,
such as Part, Assembly, and Sketch Mode.

Creating a New Sketch
To enter Sketch Mode, you need to create a new sketch. You can do this by going to the Create
tab in the toolbar and selecting Sketch. Alternatively, you can use the Sketch tool in the Part tab.
When creating a new sketch, you can choose from various sketch planes, such as the XY Plane,
XZ Plane, or YZ Plane. You can also create a custom sketch plane by selecting the Create
Plane tool.

Selecting a Sketch Plane
When selecting a sketch plane, consider the orientation and position of the plane relative to your
part or assembly. For example, if you're creating a part with a cylindrical shape, it's best to create
a sketch on the XY Plane. To select a sketch plane, click on the desired plane in the browser or
use the Plane tool in the Sketch tab.

Understanding Sketch Entities
In Sketch Mode, you'll work with various entities, including lines, curves, arcs, and splines. These
entities are the building blocks of your sketch, and understanding how to create and manipulate
them is crucial for creating accurate and efficient sketches. In the next section, we'll delve deeper
into the world of sketch entities.

Working with Sketch Entities



Sketch entities are the foundation of any sketch in Fusion 360. Understanding how to create and
manipulate these entities is essential for creating accurate and efficient sketches.

Creating Lines and Curves
Lines and curves are the most basic sketch entities. You can create lines and curves using the
Line and Curve tools in the Sketch tab. To create a line, select the Line tool and click on two
points in the sketch plane. To create a curve, select the Curve tool and click on multiple points in
the sketch plane.

Working with Arcs and Splines
Arcs and splines are more advanced sketch entities that can be used to create complex shapes.
You can create arcs using the Arc tool in the Sketch tab. To create an arc, select the Arc tool
and click on two points in the sketch plane. Splines are created using the Spline tool. To create a
spline, select the Spline tool and click on multiple points in the sketch plane.

Understanding Constraints and Dimensions
Constraints and dimensions are essential for creating accurate and efficient sketches. Constraints
define the relationships between sketch entities, while dimensions define the size and shape of
the entities. In the next section, we'll explore the world of constraints and dimensions.

Understanding Constraints and Dimensions
Constraints and dimensions are crucial for creating accurate and efficient sketches.
Understanding how to apply constraints and dimensions is essential for achieving the desired
shape and size of your part or assembly.

Applying Constraints
Constraints define the relationships between sketch entities. You can apply various constraints,
including Coincidence, Perpendicular, and Tangent. To apply a constraint, select two or more
sketch entities and click on the desired constraint in the Constraints panel.

Understanding Dimensions
Dimensions define the size and shape of sketch entities. You can add various dimensions,
including Length, Width, and Angle. To add a dimension, select a sketch entity and click on the
desired dimension in the Dimensions panel.

Understanding Assembly Constraints



Assembly constraints define the relationships between parts in an assembly. You can apply
various assembly constraints, including Mate and Joint. To apply an assembly constraint, select
two or more parts in the assembly and click on the desired constraint in the Constraints panel.

Conclusion
Entering Sketch Mode in Fusion 360 is a fundamental skill for users of this powerful 3D CAD
software. By following the steps outlined in this comprehensive guide, you'll be able to create
accurate and efficient sketches with ease. Remember to always practice and experiment with
different sketch entities, constraints, and dimensions to master the art of sketching in Fusion 360.

FAQ

Q: What is Sketch Mode in Fusion 360?
A: Sketch Mode is a fundamental mode in Fusion 360 where you can create and work with
sketches. Sketches are two-dimensional representations of a part or assembly.

Q: How do I enter Sketch Mode in Fusion 360?
A: To enter Sketch Mode, go to the Create tab in the toolbar and select Sketch. Alternatively, you
can use the Sketch tool in the Part tab.

Q: What are sketch entities?
A: Sketch entities are the building blocks of a sketch in Fusion 360. They include lines, curves,
arcs, and splines.

Q: How do I create a new sketch in Fusion 360?
A: To create a new sketch, go to the Create tab in the toolbar and select Sketch. Alternatively,
you can use the Sketch tool in the Part tab.

Q: What are constraints in Fusion 360?
A: Constraints define the relationships between sketch entities. You can apply various
constraints, including Coincidence, Perpendicular, and Tangent.

Q: What are dimensions in Fusion 360?
A: Dimensions define the size and shape of sketch entities. You can add various dimensions,
including Length, Width, and Angle.



Q: How do I save a sketch in Fusion 360?
A: To save a sketch, go to the File menu and select Save. You can also use the Ctrl+S shortcut
to save the sketch.
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Get The Complete 

Practice Sample
You downloaded a single Exercise PDF

What you will receive
• A software-specific complete sample PDF

• Multiple real practice exercises (not a single file)

• Same quality as our professional training material

• Compatible with the latest software version

The complete practice sample for this software includes multiple 

exercises and is not available inside this PDF.. 

How to get the complete sample
Click the button below and enter a valid email address.

The complete sample PDF will be delivered automatically
after the form is submitted.

SEND THE COMPLETE SAMPLE TO MY EMAIL

http://link.cadin360.com/pdf-form/?utm_source=singleSamplePdf&utm_medium=pdf&utm_campaign=autodesk-fusion-360-exercise
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Are you a Student, Unemployed or Financially struggling ?
Get this special Bundle only for $19.99

Get the Complete Bundle for Only $27.99

Get the Complete Bundle for Only $27.99

Special Offer for Students & Learners

Special Offer for Only $19.99

Special Offer for Only $19.99

END OF SAMPLE

What’s Included in the
 FUSION 360 ALL IN ONE WORKBOOK?

✓ Books contains exercises of Sketching, 3D 
Modeling & Assembly.

✓ 500+ Practice Exercises with Dimensions
✓ Full Assembly STEP Files (.stp format) – 

Compatible with all major CAD software
✓ Get 200 3D Exercises in .f3d file format
✓ Get All Assembly Exercises in .STP file
✓ Instant Download Link - Sent to Your Email 

After Payment
✓ Lifetime Access to All Files

Get the Paperback book on Amazon

Get the Paperback book on Amazon

https://link.cadin360.com/r/gsIn-s
https://link.cadin360.com/r/gsIn-s
https://link.cadin360.com/r/zdO5Nv
https://link.cadin360.com/r/zdO5Nv
https://link.cadin360.com/r/LzqWo5
https://link.cadin360.com/r/LzqWo5
https://link.cadin360.com/r/LzqWo5


 Thank You for Learning with Us!

Thank you for choosing the AutoDesk Fusion 360 ALL IN ONE WORKBOOK. We hope this 
book helped you strengthen your Fusion 360 skills through hands-on practice and real-
world design challenges.
Your feedback means the world to us!
If you found this book helpful, please take a moment to leave a review on the Amazon 
where you purchased it. Your kind words not only motivate us but also help other learners 
discover our resources. Scan the QR.

 A good review goes a long way!

 Explore More CAD Practice Books
Looking to continue your learning journey?
We offer similar practice-based books for 
over 30 CAD software platforms, including:
• AutoCAD
• SolidWorks
• FreeCAD
• TinkerCAD
• TurboCAD
• Siemens NX
• CATIA
• Creo
• SketchUp and many more...
Visit our website  www.cadin360.com to browse the complete collection.

 Stay Connected
Have suggestions, feedback, or just want to say hello?
We’d love to hear from you!

 Email: cadin360@gmail.com
 Website: www.cadin360.com

 Keep Practicing. Keep Designing.
Whether you're a beginner or a pro, practice is the key to mastering any CAD software. 
We're honored to be a part of your journey.
Happy Designing!
– Team Cadin360

https://www.cadin360.com/
http://www.cadin360.com/
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FUSION 360 ASSEMBLY DRAWINGS

A U T O D E S K

                 FOR PRACTICE

ABOUT THE BOOK

❖ S.I Units 

❖ Predominantly used Third Angle Projection.

❖ This book provides Assembly practice drawings.

❖ This book is for FUSION 360 and Other Feature-Based Modeling Software such as 

Autodesk Inventor, Catia, SolidWorks, NX, Solid Edge, AutoCAD etc.

❖ It is intended to provide Drafters, Designers and Engineers with enough CAD 

Assembly exercises for practice on FUSION 360.

❖ It includes almost all types of exercises that are necessary to provide, clear, concise 

and systematic information required on industrial machine part drawings. 

❖ Third Angle Projection is intentionally used to familiarize Drafters, Designers and 

Engineers in Third Angle Projection to meet the expectation of world wide Engineering 

drawing print.

❖ Clear and well drafted drawing help easy understanding of the design.


